Chapter 15

Introduction to
Injection Mold
Design

Learning Objectives

After completing this chapter, you will be able to:
* Understand the component required in mold design

* Analyze the part fill

* Create core and cavity for the model

* Specify location for gates and runners

* Create mold base for the component

* Create cooling channel for mold

* Create ejection system for mold
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INTRODUCTION TO INJECTION MOLD DESIGN

Injection molding is a process of manufacturing parts by injecting molten material into the mold.
You can process thermoplastic as well as thermosetting polymers to create parts in injection
molding machine.

An injection mold is an assembly of parts containing an impression into which plastic material
is injected and cooled. This impression is formed by two parts of the mold:

(1) Cavity

(i1) Core

In NX, you can design a mold by using the tools available in the Mold Wizard environment.

INVOKING THE MOLD ENVIRONMENT

Before starting NX Mold Wizard, you need to add NX Mold Wizard library to NX. After that,
you can use standard parts and material library to create a mold. Start NX by double-clicking
on the shortcut icon of NX on the desktop of your computer. After the system gets loaded with
all the files to start NX, the initial interface will be displayed, as shown in Figure 15-1.
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Figure 15-1 The initial interface that appears afler starting NX

Next, choose File > Open from the Ribbon; the Open dialog box will be displayed, as shown
in Figure 15-2.

Now, select the file and choose the OK button; the file will be opened in the Modeling
Environment, as shown in Figure 15-3.

To invoke the NX Mold Wizard, choose the Application tab and then choose the Mold tool
from the Process Specific group; the Mold Wizard tab will be displayed next to the Application
tab, refer to Figure 15-4.
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Figure 15-2 The Open dialog box
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Figure 15-3 The Modeling environment displayed on screen
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Figure 15-4 The Mold Wizard environment displayed on screen

VARIOUS METHODS FOR CREATING MOLD DESIGN
In NX, you can use the following methods for designing an Injection Mold:

(1) Manual

(i1) Semi Automatic

(111) Automatic

These methods are discussed next.

Manual Method
In manual method, you will not use Mold Wizard but will use Part Modeling, Surfacing, and
Assembly environments.

Semi Automatic Method
In semi automatic method, you will use a combination of Mold Wizard, Part, Surfacing, and
Assembly environments.

Automatic Method

In automatic method, you will use only Mold Wizard environment for designing an injection mold.

ANALYSIS OF PART

For analyzing the part in NX, the Easy Fill Advanced plugin is being used in this book. You can
also use Run Flow Analysis for analyzing the part but due to some constraints in the results the
Easy Fill Advanced plugin is preferred for analysis.

As you install the Easy Fill Advanced plugin; the Easy Fill Advanced tab will becomes available
in NX interface. Figure 15-5 shows the Easy Fill Advanced tab.
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Before analyzing the part using the Easy Fill Advanced plugin, you should check the part
undercut, draft angle, and wall thickness using the Mold Design Validation and Check Wall

Thickness tools.

Mold Design Validation

Ribbon:
% This tool helps to check the quality of the molded

part. To check the undercut, draft angle, and

mold part quality, invoke the Mold Design
Validation tool from the Part Validation gallery of the
Mold Wizard tab; the Mold Design Validation dialog
box will be displayed, as shown in Figure 15-6. The
options in this dialog box are discussed next.

Component Validation

The check boxes available in this area helps to find
out interference between the electrodes and the
overlapping of core and cavity sheets.

Product Quality
The check boxes available in this area helps to find out
the undercut and the draft angle of the molded part.

Parting Validation

The check boxes available in this area helps to find
out the face required to split and checks overlap patch
surface.

As you choose the Execute Check-Mate button from the
Parameters rollout of the dialog box; the HD3D Tools

Mold Wizard > Part Validation Gallery > Mold Design Validation

3} Mold Design Validation
Checkers A

- Component Validation
] Electrode
[] Core/Cavity
[]Pocket
-+ Product Quality
[] Mold Part Quality
[] Model Quality
- Parting Validation
[] Overlap Patch Surface
[] Unsplit Faces
[] Sheet Body Boundary

Parameters A

Figure 15-6 The Mold Design
Validation dialog box

window will be displayed, as shown in Figure 15-7. Depending upon the check box selected in
the Mold Design Validation dialog box, the resulting parameter will be displayed in the HD3D
Tools window. In this window, the status of the result is shown by symbols. Following are the
symbols with their meanings:

Ed This symbol shows the result passed but with information.

This symbol shows the result passed but with warning.

This symbol shows the result passed.
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Check Wall Thickness

Ribbon: Mold Wizard > Part Validation Gallery > Check Wall Thickness
Menu: Analysis > Molded Part Validation > Check Wall Thickness

Part with uniform thickness allows the mold cavity to fill more easily since the molten
% plastic does not have to be forced through varying restrictions as it fills. If the walls are

not uniform then the thin section cools first as compared to thick section which leaves
warpage or sink mark in part. You can analyze the thickness using the Check Wall Thickness
tool. To analyze the thickness of part, invoke the Check Wall Thickness tool from the Part
Validation gallery of the Mold Wizard tab; the Check Wall Thickness dialog box will be
displayed, as shown in Figure 15-8, and solid body will be selected in the Body rollout. Choose
the Calculate Thickness button from the Process Results rollout to analyze the solid body; the
result will be displayed, as shown in Figure 15-9. Choose the OK button to close the dialog box.
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Figure 15-7 The HD3D Tools window Figure 15-8 The Check Wall

Thickness dialog box
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Figure 15-9 The Part with thickness analysis

Easy Fill Advanced

The tools in the Easy Fill Advanced plugin help you to simulate filling, packing and runner
balancing of injection molding. Next, you need to understand why this plugin is preferred to
use over NX run flow analysis.

Parameter Easy Fill Easy Fill Advanced
1) Simulation capabilities Filling Filling and Packing
2) Runner balance N/A YES
3) Gate Number Multiple Multiple
4) Results availability 10 36 (filling+packing)
5) Section Results N/A YES

This tab comprises of various tools which are discussed next.

Set Working Folder

Ribbon: Easy Fill Advanced > Setting > Set Working Folder
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Set Working Folder

This tool helps you to locate the analysis result in the specified folder. To set the working
sawersny folder, choose the Set Working Folder tool from the Setting group of the Easy Fill
Advanced tab; the Working Folder dialog box will be displayed, as shown in Figure 15-10.
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Figure 15-10 The Working Folder dialog box

Note

If the Easy Fill Advanced message box appears afier choosing the Set Working Folder tool then
choose the Yes button to close this message box.

To locate the folder location, choose the Browse button from the Working Folder dialog box;
the Open dialog box will be displayed, as shown in Figure 15-11. From this dialog box, you can

set the directory of the analysis result. After specifying the directory of the analysis result, choose
the OK button twice to close the dialog boxes.
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Figure 15-11 The Open dialog box
Set Cavity

Ribbon: Easy Fill Advanced > Setting > Set Cavity
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Set Cavity

This tool helps you to specify the cavity of the component and assign material to the

@ component. To specify the cavity, choose the Set Cavity tool from the Setting group in
sst the Easy Fill Advanced tab; the Select Cavity dialog box will be displayed, as shown
cavity in Figure 15-12. Also, you will be prompted to specify solid body as cavity. Select the
component from the drawing window. Next, choose the Push button to select material
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button from the Material Setting rollout; the Moldex3D Material Wizard dialog box will be
displayed, refer to Figure 15-13. You can specify the name of material, producer name, and
grade name in this dialog box. After specify the material, producer, and grade name; choose
the OK button from the Moldex3D Material Wizard dialog box and next, choose the OK button
from the Select Cavity dialog box.

{3 Select Cavity O X
Cavity Setting A @ Moldex3D Material Wizard X
¥ Select Body (0) @
Material: IABS =l
Material Setting A Producer: IA_ Schulman j
Material
o Grade Name: |POLYFLAM RABS 90000 UVE ~|
Advanced... | oK
Cancel
Figure 15-12 The Select Cavity dialog box Figure 15-13 The Moldex3D Material
Wizard dialog box
Set Runner
Ribbon: Easy Fill Advanced > Setting > Set Runner
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Set Runner

system, choose the Set Runner tool from the Setting group in the Easy Fill Advanced

st  tab; the Select Runner dialog box will be displayed, as shown in Figure 15-14. Choose

Runner the Specify Runner button from the Runner List rollout; the Select Runner dialog box

will be displayed, refer to Figure 15-15. Also, you will be prompted to specify the curve

or solid body to specify as Runner. Select the solid body or curve from the drawing window.

Choose the OK button to close the dialog box; the Settings dialog box will be displayed. You

can select type of runner from the Type drop-down list of the Attribute rollout. Choose the OK

button to close the dialog box. You will notice that type of runner and name of runner will be
displayed in the Runner List rollout. Choose the OK button to close the dialog box.

£} Select Runner O X

? This tool helps you to define the runner system of the solid bodies. To set the runner

Runner List A
1_-*_ £ Select Runner X
.;':33 Objects A
Select Objects (0) -
X

Select All @
o
Invert Selection @

-

Figure 15-14 The Select Runner dialog box  Figure 15-15 The Select Runner dialog box
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S Note
@ If you select a body for setting runner; then you can only deﬁne type of runner but if you select a
curve, then you can define type of runner and its cross-section parameters.

Set Melt Entrance

Ribbon: Easy Fill Advanced > Setting > Set Melt Entrance
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Set Melt Entrance

a Melt entrance is the path through which molten material comes into the runner. To set

the Melt Entrance for the runner, choose the Set Melt Entrance tool from the Setting

setMelt  group of the Easy Fill Advanced tab; the Melt Entrance Setting dialog box will be
displayed, as shown in Figure 15-16.

Next, choose the Specify Melt Entrance Position button from the Melt Entrance List rollout;
the Point dialog box will be displayed, refer to Figure 15-17. By using this dialog box, you can
place the Melt entrance position. Choose the OK button to close the dialog box. You will notice
the Melt Entrance name in the Melt Entrance List rollout. Choose the OK button to close the
dialog box.

£} Point O X
Type A
‘Cj’ Point on Face - ‘
Face A
% Select Object (0) &7
Location on Face A
U Parameter -
V Porameter
Output Coordinates A
Reference |WCS - |
{} Melt Entrance Setting O X HC 0.0000000000' mm
Melt Entrance List A YT 0.0000000000! mm -
7c | 0.0000000000( mm |
c&’ Offset A
X Offset Option Mone -
&

o | B = (o

Figure 15-16 The Melt Entrance Setting dialog box Figure 15-17 The Point dialog box
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Set Parting Direction

Ribbon: Easy Fill Advanced > Setting > Set Parting Direction
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Set Parting Direction

% Parting direction of the component plays an important role in mold design procedure.
setrng 00> YOU need to decide the parting direction carefully. To set the parting direction,
orection choose the Set Parting Direction tool from the Setting group in the Easy Fill Advanced

tab; the Vector dialog box will be displayed, refer to Figure 15-18. Select the direction
of the partition by selecting the option from the Type drop-down list of the rollout. After
specifying the correct orientation of the axis, choose the OK button to close the dialog box.

Gate Wizard

Ribbon:  Easy Fill Advanced > Wizard > Gate Wizard
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Wizard > Gate Wizard

This tool helps you to create gate for analysis of flow. To create a gate, choose the Gate

ﬁ Wizard tool from the Wizard group in the Easy Fill Advanced tab; the Create Gate

cate  dialog boxwill be displayed, refer to Figure 15-19. Choose the Point Dialog button from

wizard the Position of Gate rollout; the Point dialog box will be displayed. Using this dialog

box specify the location of the gate and then choose the OK button to close the dialog

box. Select the type of gate from the Type of gate drop-down of the Attribute rollout. Specify
the dimensions of the gate cross-section from the Cross-Section Parameters rollout.

£} Create Gate O X
Position of Gate A
% Select Paint (0) AR
Attribute A
Type of gate Pin Gate hd
Attribute Cold Runner Gate -
Cross-Section Parameters A
D2
p—
£} Vector O X
L
G -ZC-axis L
Vector Orientation A D1
Reverse Direction X D1: . D2 €.00000 2
Gate length(L) 6.00000 2

-

b
Cancel

Figure 15-18 The Vector dialog box Figure 15-19 The Create Gate dialog box
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In NX, the Easy Fill Advanced plug-in supports various types of gates :

i.  Pin Gate

ii. Sprue Gate

iii. Edge Gate

iv. Fan Gate

v. Lapped Edge Gate

vi. Tunnel Gate

vil. Cashew Gate

viii. Tunnel Gate with ejector pin
ix. Cashew Gate with ejector pin

You can also set them as a Cold Runner or a Hot Runner gate. Depending upon the selection
of gate, the dimension parameters of gate also gets changed. You can define the size of the gate
by entering value in the edit boxes of these parameters. After entering the values, choose the
OK button to close the dialog box.

Runner Wizard

Ribbon: Easy Fill Advanced > Wizard > Runner Wizard
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Wizard > Runner Wizard

#& This tool helps you to create runner system for gy o

flow analysis of material. You need to select only
runner the gate location and it’s size in the model, as a
Wiard  result, the ranner wizard automatically calculates | Poinsdrcion e

it’s size, shape, and layout. This tool helps not Plteme
only in creation of Runner but also helps in designing
sprue and melt entrance. With the help of this tool, you
can design runner system more efficiently. To create a
Runner, choose the Runner Wizard tool from the Wizard j
group in the Easy Fill Advanced tab; the Runner Wizard
dialog box will be displayed, refer to Figure 15-20.

Meold Setting | Sprue Setting  Runner setting

Runner Attribute Cold Runner h

Parting Plane Position A

Gate plane

Fart

Mold Setting
This tab allows you to define the parting direction,
mold plate type, and runner attribute.

Cancel

The options of this tab are discussed next.

Figure 15-20 The Runner Wizard

Parting Direction: The options in this drop-down ;. o box

are used to specify the orientation of the runner.
The orientation may be along X-axis, -X-axis,
Y-axis, -Y-axis, Z-axis, -Z-axis or customize it
along any vector direction.

Mold Plate Type: The options in this drop-down are used to specify the type of mold.
According to the selection of the mold plate type the parameters of parting line or plane
gets changed. The options in this drop-down list are:
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(1) 2-Plate mold
(11) 3-Plate mold

Runner Attribute: The options in this drop-down are used to define the type of runner.
The options in this drop-down list are:

(1) Cold Runner

(11) Hot Runner

Sprue Setting
This tab allows you to define the sprue position, sprue length, and sprue diameter. The
options of this tab are discussed next.

Sprue Position Rollout: The options in this rollout are used to position the sprue.

Sprue Geometry Parameters Rollout: The options in this rollout are used to specify
the size parameters of sprue.

Runner setting
This tab allows you to specify the cross-section and size parameters of runner.

After specifying the parameters of runner, choose the OK button to close the dialog box.

Melt Entrance Wizard

Ribbon: Easy Fill Advanced > Wizard > Melt Entrance Wizard
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Wizard > Melt
Entrance Wizard

This tool helps you to specify from where molten material comes. To create melt

ﬁ entrance, choose the Melt Entrance Wizard tool from the Wizard group in the Easy

Melt Fntrance  Fill Advanced tab. As you choose this tool, the melt entrance automatically gets
place in gate or runner location.

Start Analysis
Ribbon: Easy Fill Advanced > Setting > Start Analysis
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Start Analysis

= This tool helps you to apply the settings for the analysis of the component. To start the
= analysis of the component, choose the Start Analysis tool from the Setting group in
start  the Easy Fill Advanced tab; the Analysis Setup dialog box will be displayed, refer to
Analysis - Figure 15-21. You can specify the process parameters, type of analysis, and the mesh
level in this dialog box. Choose the OK button to start the analysis; the Moldex3D
SYNC Project Monitor window will be displayed. This window shows the progress of analysis.
After the analysis is complete, close this window by choosing the Close button; the Moldex3D
eDesignSYNC message box will be displayed showing that all tasks have been completed. Choose
the OK button to exit this message box.
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£} Analysis Setup D X
Analysis Set M
Rermark Runl
Analysis Filling - F -
Process Condition A
Mazx. Injection Pressure (MPa) 250.0000
Filling time (sec.) 1.4100
Melt Ternperature (*C) 260.0000
Meld Temperature (°C) &0 .0000
Mesh A
Meshing Size 1.4500
Computing Setting A
Mo, task ] -

Start Analysis Immediately

F

Figure 15-21 The Analysis Setup dialog box

Show Result
Ribbon: Easy Fill Advanced > Setting > Show Result
Menu: Analysis > Molded Part Validation > Easy Fill Advanced > Show Result

This tool helps you to visualize and analyze the result. To invoke this tool, choose the
g Show Result tool from the Setting group of the Easy Fill Advanced tab; the Show
show Result dialog box will be displayed, as shown in Figure 15-22. Select result from the
Result  Analysis Result rollout; the dialog box gets modified, refer to Figure 15-22. You can

select the Filling or Packing option from the Analysis drop-down list in the Display
Result rollout. By default, the Filling option is selected. You can visualize the results by selecting
appropriate option from the Result Type drop-down list. Choose the Close button to close the
dialog box.
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£} Show Result O X
Analysis Result A
Hund 5%
Description
Run3
Display Result A
Criteria None MIF:
Display Mode Classic Mode -
Analysis Filling -
Result Type Melt Front Time -
£} Show Result O X ] % Blot
Analysis Result A Result Adviser
Rund 4 Display Setting v
Animation Setting v
Views Tool v
Description Save Animation as Files v
Generate Report v
| Export Result to Moldex3D Viewer v

Close

-

Close

Figure 15-22 The Show Result dialog box and its modified version

MOLD WIZARD

The Mold Wizard tab contains tools that help you to design injection mold automatically. Before
using this wizard you should ensure that the library related to the mold is installed. The tools

in this wizard are discussed next.

Initialize Project
Ribbon: Mold Wizard > Initialize Project

=1 The Initialize Project tool is used to create a new mold
18]  design project or to add new model to create a family
e mold. Choose the Initialize Project tool of the Mold
Wizard tab, the Initialize Project dialog box will be
displayed, as shown in Figure 15-23.

To specify the path of the project, choose the Browse button
from the Project Settings rollout; the Open dialog box will be
displayed, as shown in Figure 15-24.

Specify the path of the project and then choose the OK button
to close the dialog box. Select the name of the material from
the Material drop-down list of the Initialize Project dialog

€ Initialize Project 0 X

Project Settings A

Path

I\ Powork_20194NX_1847\Manuscript\c13_no

Mame

Cover_Plastic
Material NYLON -
Shrinkage 1.016
Configuration Mold.V1 -

-

Figure 15-23 The Initialize
Project dialog box

box. Next, choose the OK button to close the dialog box; the New Iray+ Ray Traced Studio
Rendering window will be displayed. Choose the OK button to close the window.
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* MName . Date modified Type Size
. Cover_Plastic 8/3/2019 5:33 AM File folder
Guick access
Deskiop
"
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This PC
Network
Dirsctory: I’vuscript\c15_nx_2|]19\C15_NX_2|]19_input\mo\d\] oK |
Files of type [Directories | Cancel |

Figure 15-24 The Open dialog box

Mold CSYS
Ribbon:

o
:

Mold Wizard > Main Gallery > Mold CSYS

The Mold CSYS tool is used to reposition the original component to the correct orientation
according to the mold assembly or to the injection molding machine. While positioning

the component, you should consider following points while placing the component in

mold wizard:

* Orient the component so that ejection occurs in z-axis of the mold base.
* Position the component in such a way that parting plane lies on X-Y plane.

To orient the component, invoke the Mold CSYS tool from the Main gallery of the Mold Wizard
tab; the MOLD CSYS dialog will be displayed, refer to Figure 15-25.

£ Mold CSYS O X
Change Product Position A
O Cument WCS

@ Product Body Center
O Center of Selected Faces
Lock XYZ Position A

[ Lock X Position
[ Lock Y Position
Lock Z Position

-

Apply Cancel

Figure 15-25 The Mold CSYS dialog box

In the Change Product Position rollout of this dialog box, there are three options to change
the position of the component. These options are discussed next.
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Current WCS

Select this radio button to reposition the component from the current WCS position and
orientation to the position and orientation of the mold base.

Product Body Center

Select this radio button to reposition the WCS to the center of the component body. When you
select this radio button, the Lock XYZ Position rollout will be displayed. The options in this
rollout help you to lock the position of X,Y, and Z coordinates of the component.

Center of Selected Faces

Select this radio button to reposition the component from the center of one or more selected
faces to the origin of the mold base. As you select this radio button, the Lock XYZ Position
rollout gets available. The options in this rollout help you to lock the postion of XY, and Z
coordinates of the component.

Shrinkage
Ribbon: Mold Wizard > Main Gallery > Shrinkage

%l When a molten plastic filled inside a mold is cooled, it solidifies and shrinks to some
extent, this process is known as Shrinkage.

The Shrinkage tool helps you to apply the scale factor on the product model. While defining
the scale factor, you should consider the following points:

* Type of molding material.

*  Wall thickness of the molded part.

*  Cavity surface temperature.

*  Gate shape.

* Presence of additive material to the molding materials.

To apply shrinkage on the model, choose the Shrinkage tool from the Main gallery of the Mold
Wizard tab; the Scale Body dialog box will be displayed.

Type Drop-down List
This drop-down list is used to specify the type of shrinkage that you need to apply to the
component.

Uniform
This option is used to scale the body uniformly in all directions.

Axisymmetric
This option is used to scale the body symmetrically with a specified scale factor about
specified axis.

General
This option is used to scale the body with different scale factors along the XY and Z
directions.
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After scaling the body, choose the OK button to close the dialog box.

Check Regions
Ribbon: Mold Wizard > Parting Tools Gallery > Check Regions

~—— The Check Regions tool is used to analyze the draft angle of faces, set the color in the
™ faces according to the draft values, and find undercut in the model. It also helps to find
the core and cavity regions in the model. To analyze the core and cavity region of the model,
invoke this tool from the Parting Tools gallery of the Mold Wizard tab; the Check Regions
dialog box and the Parting Navigator window will be displayed, refer to Figures 15-26 and
15-27. Choose the Calculate button in the Calculate rollout and then choose the Region tab.
In this tab, choose the Set Regions Color button from the Define Regions rollout; the color of
the model gets changed. These colors represent core, cavity, and undefined region in the model.

{3} Check Regions O X

Calculate | Face  Region  Information

Product Body and Direction A

@

/" Specify Draw Direction X Wl T}5 -

+/" Select Product Body (1)

Calculate A

@ Keep Exlstlr‘lg Parting Objects Count Layer [[n]
(D Edit Regions Only — = Parting Design
O Reset All +0 Product Body 1 1
- Dn:ﬂ Workpiece 1 20
[ Workpiece Wireframe
Calculate = -Oe
0%

Dle/

D@
T"Dt{‘i Cavity
+ Dtﬁ Core

Cancel

Figure 15-26 The Check Regions dialog box Figure 15-27 The Parting Navigator window
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The Cavity Region radio button is selected by default in the Assign To Region rollout. Select
the undefined region of the model and then choose the Apply button. The undefined region
gets the color of the cavity region. Choose the OK button to close the dialog box.

Patch Surface
Ribbon: Mold Wizard > Parting Tools Gallery > Patch Surface

@ This tool is used to create sheets to close openings in the model. To patch a surface,

choose the Patch Surface tool from the Parting Tools gallery of the Mold Wizard tab;

the Edge Patch dialog box will be displayed, refer to Figure 15-28. In NX Mold Wizard, you

have three options in the Type drop-down list of the Loop Selection rollout: Face, Body, and
Traverse.

{3} Edge Patch 0 X
Loop Selection A
Type v Traverse -
Traverse Loop A

Loop A
% Select Edge/Curve (D) @
Segments A

& | B
« 90w

Traverse by Face Color

[ End Edge
Tolerance 0.0100]
Loop List A
¥ Select Loop (0)
List A
X
\\
Settings v

Cancel

Figure 15-28 The Edge Patch dialog box



15-20 Siemens NX 2019 for Designers

Define Regions
Ribbon:  Mold Wizard > Parting Tools Gallery > Define Regions

4= This tool is used to create core and cavity region sheets, parting lines, and other region

sheets (for sliders and lifters). To create core and cavity region sheets, choose the Define
Regions tool from the Parting Tools gallery of the Mold Wizard tab; the Define Regions dialog
box will be displayed, refer to Figure 15-29.

In the Define Regions rollout, you can examine the number of faces selected for cavity, core, and
undefined faces which help you to identify the number of faces belonging to core and cavity.
The procedure to create regions for core and cavity will be discussed in Tutorial 1.

Design Parting Surface
Ribbon:  Mold Wizard > Parting Tools Gallery > Design Parting Surface

ﬁ?b This tool is used to create a parting surface of the component. To create parting surface,
invoke the Design Parting Surface tool from the Parting Tools gallery of the Mold Wizard
tab; the Design Parting Surface dialog box will be displayed, refer to Figure 15-30. You

can use the tools available in the Auto Create Parting Surfaces rollout to create parting

surfaces.
{3} Define Regions O X
Define Regions A L} Design Parting Surface O X
Region Mame Count La Parting Lines A
4% All Faces 92
' Undefined Faces 0 ¥ Select Parting Lines (0) /
| Cavity region 18 28 Parting Segments A
(€ Core region 75 27 Parting Segments Delete Part...  Parting
| MNew region 0 29
< >
< >
Create New Region
Auto Create Parting Surfaces A
¥ Select Region Faces (0) Ii‘%
= Auto Create Parting Surfaces @
Search Region f—
Delete All Existing Parting Surfaces ><
Settings A

Edit Parting Lines
[] Create Regions

[] Create Parting Lines

Edit Parting Segments
Settings

Cancel Cancel

Figure 15-29 The Define Regions dialog box Figure 15-30 The Design Parting Surface
dialog box
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Edit Parting and Patch Surface

Ribbon:  Mold Wizard > Parting Tools Gallery > Edit Parting and Patch Surface

@ This tool is used to delete parting and patch sheets. To edit parting and patch surface,

choose the Edit Parting and Patch Surface tool from the Parting Tools gallery of the

Mold Wizard tab; the Edit Parting and Patch Surface dialog box will be displayed, refer

to Figure 15-31. You can select the type of surface to be edited from the Type drop-down list of
the Type rollout.

L} Edit Parting and Patch Surface O X
fg* Patch Surface Lw
Patch Surface A
% Select Sheet Body (0) {

v
Cancel

Figure 15-31 The Edit Parting and Patch Surface dialog box

Workpiece
Ribbon:  Mold Wizard > Main Gallery > Workpiece

This tool helps you to define the size of core and cavity. To define the size, choose the
@ Workpiece tool from the Main gallery of the Mold Wizard tab; the New Iray+ Ray

Traced Studio Rendering window will be displayed. Choose the OK button from this
window; the Workpiece dialog box will be displayed, refer to Figure 15-32. The options in this
dialog box are discussed next.

Type Drop-down List
The options in the drop-down list are used to define whether you want to create core and cavity
for single component or multiple components.

Product Workpiece
This option helps you to create the core and cavity for single component.

Combined Workpiece
This option helps you to create the core and cavity for multiple components.

Workpiece Method Rollout

The options in the drop-down list in this rollout are used to define the way you want to create
the workpiece. The options available in the drop-down list are:

(1) User Defined Block

(i) Cavity-Core
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(ii1) Cavity Only
(iv) Core Only

{3} Workpiece O X
9 Product Workpiece -
Workpiece Method A

Workpiece Method

Dimensions A
Define Workpiece A
Definition Type Sketch -

Section M

./ Select Curve (4) X|2|1e
Specify Origin Curve D

Limits IS
Start fip) Value -
Distance 15 mm -
End fip) Value -
Distance 125 mm -

Reset Sizes O

Product Maximum Size:
X =1248%8 ¥ =101.600
Z_down = 50,800 £ _up=101.600

Preview Show Result ):’

-

Figure 15-32 The Workpiece dialog box

Dimensions Rollout
The options in this rollout help you to define the size of the workpiece. After specifying the size
of the workpiece, choose the OK button to close the dialog box.

Cavity Layout
Ribbon:  Mold Wizard > Main Gallery > Cavity Layout

This tool helps you to create the layout of core and cavity workpiece. To do so, choose
I__r”_—l the Cavity Layout tool from the Main gallery of the Mold Wizard tab; the Cavity Layout

dialog box will be displayed, refer to Figure 15-33. Also, the workpiece will be selected
automatically, as shown in Figure 15-34. The options available in various rollouts of the Cavity
Layout dialog box are discussed next.
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Generate Layout
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Figure 15-33 The Cavity Layout dialog box
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Figure 15-34 The workpiece selected automatically

Product Rollout

The option in this rollout is used to select the workpiece.
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Layout Type Rollout
The options in this rollout are used to specify the type of orientation to be created. The options
available in this rollout are discussed next.

Layout Type

The options in this drop-down list are used to define
the layout type for the cavity. The Rectangular option  cses | oimerson

in this drop-down list is selected by default and helps G [tove | Cesirzion [hone ©

you to create rectangular layout of the workpiece. You o i .
can also choose the Circular option from this

drop-down list to create a circular layout of the SN
component. The Specify Vector area in the Layout

Type rollout helps you to define the directional
placement of the component with respect to other

component. Specify the parameter of the layout in the .
Balanced Layout Settings or Circular Layout Settings

rollout. To create the rectangular or circular

layout, choose the Start Layout button from the
Generate Layout rollout; the preview of the layout will

be displayed in the window. After that, choose the Edit

@ True O False (O Both

Insert Pocket button from the Edit Layout rollout; i PH
the Insert Pocket dialog box will be displayed, refer .,
to Figure 15-35. Select the desired value from the R and o |

type drop-down lists. Choose the OK button to close )

the dialog box. Next, choose the Close button from F igure 15-35 The Insert Pocket
the Cavity Layout dialog box. Figures 15-36 and 15-37  dialog box

show the rectangular and circular layouts respectively.
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Figure 15-36 The rectangular layout of workpiece
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Figure 15-37 The circular layout of workpiece
Define Cavity and Core
Ribbon:  Mold Wizard > Parting Tools Gallery > Define Cavity and Core
This tool helps you to create core and cavity of :
== the component. To create core and cavity of the 13 Define Cavity and Core Se
model, choose the Define Cavity and Core tool [ @ pegion -
from the Parting Tools gallery of the Mold Wizard tab;
the Define Cavity and Core dialog box will be = Select Sheets A

displayed, refer to Figure 15-38. In the dialog box, the
Cavity region area is selected by default in the Select
Sheets rollout. Choose the Apply button; the New
Iray+ Ray Traced Studio Rendering window will be
displayed. Choose the OK button; the View Parting
Result dialog box will be displayed. Check if the core
or cavity is correct otherwise choose the Reverse
Normal button. Choose the OK button; the Define
Cavity and Core dialog box is displayed again. Select
the Core region area from the Select Sheets rollout.
Choose the Apply button; the New Iray+ Ray Traced
Studio Rendering window will be displayed. As you
choose the OK button to close the window; the View
Parting Result dialog box will be displayed. Check the
core or cavity is correct otherwise choose the Reverse
Normal button. Choose the OK button to close the
window; the Define Cavity and Core dialog box
displayed again. Choose the Cancel button to close the
dialog box. Click the left mouse button and then choose
the Switch Window tool from the popup mini bar to
check the core and cavity window.

Region Mame
----- [ All Regions

[ Cavity region

----- [% Core region

./ Select Sheet (1)

Suppress A

Settings A

[ Mo Interaction Queries

Sew Tolerance

oK

Cancel

Figure 15-38 The Define Cavity and
Core dialog box
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Mold Base Library
Ribbon:  Mold Wizard > Main Gallery > Mold Base Library

== The Mold Base Library tool helps you to add mold plates to the core and cavity. To add

=l mold plates, choose the Mold Base Library tool from the Main gallery of the Mold

Wizard tab; the Mold Base Library dialog box is displayed, refer to Figures 15-39. Also,

the Information window, refer to Figure 15-40 and the Reuse Library navigator on the left of

the window will be displayed. Select the standard of the mold base from the MW Mold Base

Library of the Reuse library navigator and specify the size in the Details rollout of the Mold
Base Library dialog box and then choose the OK button.

£} Mold Base Library O X

o/ Select ltem (24) @

Part A

Select Mold Base ([ -q} N
© Information X
[ Concept Design

[] Rename Components

@ Tor—f | | ] clmptype
] =
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I
|
I T T
| | |
Name Value | |
' ¥ index 4545 ~ B h i 2 E
of ¥ TCP_type 2 o | '
§w AP_h 146 | i
5o “| || R
'+ BP_h 76
v CPh 126 L Ll
brp—f 1
r_‘i_ mold_w 446 P—
£EE mold_ 446 *S%CB'EdiSt_P
T offset fix 0 = -
£ >
- Layout Size
W=210 Zup =35
Apply Cancel L =135 7_down = 25
Figure 15-39 The Mold Base Library Figure 15-40 The Information
dialog box window

Standard Part Library
Ribbon:  Mold Wizard > Main Gallery > Standard Part Library

@ The Standard Part Library tool helps you to add the standard parts in the mold like
sprue bush, locating ring, and so on. To add a standard part, choose the Standard Part
Library from the Main gallery of the Mold Wizard tab; the Standard Part Management
dialog box will be displayed, refer to Figures 15-41. Also, the Information window will be
displayed, refer to Figure 15-42 and the Reuse Library navigator on the left in the window will
be displayed. Select the standard from the MW Standard Part Library of the Reuse Library
like locating ring and sprue bush. After specifying the parameters of the parts, choose the OK
button to close the dialog box.
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Figure 15-41 The Standard Part
Management dialog box
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Figure 15-42 The Information
window

Ribbon:  Mold Wizard > Main Gallery > Design Fill

The Design Fill tool helps you to create a gate which connects with core or cavity. To
S5 create a gate, choose the Design Fill tool from the Main gallery of the Mold Wizard tab;
the Design Fill dialog box will be displayed, refer to Figures 15-43. Also, the Information
window, refer to Figure 15-44 and the Reuse Library will be displayed on the left in the drawing
window. Select the required type of gate from the MW Standard Part Library of the Reuse
Library and then specify the parameters in the Details rollout of the Design Fill dialog box
and then choose the OK button to close the dialog box.
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{3} Design Fill O X

Component A

/" Select ltem (Runner[2])

Select Component (0)

[J Rename Compenent

Details A
Mame Value
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gfwD 3
gL 40
< >
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¥ Specify Point 7l
Settings A

[ Add Constraint

|| Cancel |

-

Figure 15-43 The Design Fill dialog box

Information X

Figure 15-44 The Information window

Ribbon:  Mold Wizard > Main Gallery > Runner

:j_g The Runner tool helps you to create the runner which connects with sprue bush and gate.
To create a runner, choose the Runner tool from the Main gallery of the Mold Wizard
tab; the Runner dialog box will be displayed, refer to Figures 15-45. Also, the Information
window will be displayed, refer to Figure 15-46 and the Reuse Library will be displayed on the
left in the drawing window. Create the sketch of the runner layout and select the type of runner
cross-section. Specify the parameters of runner and then choose the OK button to close the

dialog box.
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Guide A
% Select Curve (0) hﬁ
Section A
¥ Specify Vector \.:,T ?? -
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Section Type Circular -
Details A
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D
€ >
Tools
Settings
Preview
Cancel
Figure 15-45 The Runner dialog box Figure 15-46 The Information

window

Slider and Lifter Library
Ribbon:  Mold Wizard > Main Gallery > Slide and Lifter Library

The Slide and Lifter Library tool helps you to create a slider in mold design. lo create
GJE the slider, choose the Slide and Lifter Library tool from the Main gallery of the Mold

Wizard tab; the Slide and Lifter Design dialog box will be displayed, refer to Figure 15-47.
Also the Information window will be displayed, refer to Figure 15-48 and the Reuse Library
navigator will be displayed on the left in the drawing window. Select the type of slider from the
Member Select panel of the Reuse Library and specify the parameter in the Details rollout of
the Slide and Lifter Design dialog box. Choose the OK button to close the dialog box.
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£} Slide and Lifter Design

I X
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Figure 15-47 The Slide and Lifter Figure 15-48 The Information window
Design dialog box

Slider and Lifter Library
Ribbon:  Mold Wizard > Main Gallery > Slider and Lifter Library

G:' The Slide and Lifter Library tool helps you to create lifters in mold design. To create a
8 lifter, choose the Slide and Lifter Library tool from the Main gallery of the Mold Wizard

tab; the Slide and Lifter Design dialog box will be displayed, refer to Figures 15-49. Also,
the Information window, refer to Figure 15-50, and the Reuse Library navigator will be displayed
on the left in the drawing window. Select the Lifter from the SLIDE_LIFT sub-tree of the MW
Slide and Lifter Library tree in the Reuse Library. Select the type of lifter from the Reuse
Library and specify the parameters in the Details rollout of the Slide and Lifter Design dialog
box. Choose the OK button to close the dialog box.
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Figure 15-49 The Slide and Lifter Figure 15-50 The Information window
Design dialog box

Design Ejector Pin
Ribbon:  Mold Wizard > Main Gallery > Design Ejector Pin

This tool helps you to create ejector pins that are used for ejection of the component. To
Q create an ejector pin, choose the Design Ejector Pin tool from the Main gallery of the

Mold Wizard tab; the Design Ejector Pin dialog box will be displayed, refer to Figure
15-51. Also, the Information Window, refer to Figure 15-52 and the Reuse Library navigator
will be displayed on the left in the drawing window. Select the type of ejector pin from the
Member Select panel of the Reuse Library and specify the parameters in the dialog box. Position
the pin so that the ejection takes place and then choose the OK button to close the dialog box,
refer to Figure 15-53.
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Figure 15-51 The Design Ejector
Pin dialog box

v T 4y O - & T Switch Window [ Window - =

Home | Assemblies  Curve  Suface  PobgonModelng  Reverse Engincering  Anabysis  View  Render

o O/ e ® o G gsnmm %::’M

" O e g

enu s Noseiaionriter v [entessenby v @

L O NC )

CATALOG=EIP-EHM 1.2 X 100

X

CLEARANCE_DIa_EJ_PLATE ~ “LEARANCE_DIA_PIN

T HOLE DIA
FIN_DI4,

r C_BORE_DEEP_CLEARANCE

P -98@/ /AN +OOFIMG &

Figure 15-52 The Information window

NK- Modeling

Esy Fil Advanced

By ot
& o component

22 @gratem component

sssendies -

BE x>0 6 Hicede o

dy Lbrary
- MW Reusable Object Library

« B Reuse Bamples

+ 7 Reussble Otject Liorry (ample On)
- 5120 Secton Lbrry

< B Journal il Bample Livrary

B UDF Library

Ly Fastener Assembly Configuration Libary
- B CADENAS Lbrary

< Favortes

NOEL\ O 1A

&

Search v
Member Select ~

87

Name | Standard

Preview ¥ |+ [isometic work camera sometric

& Cove pamicpr b Couearic o 020 prt i fezemoly Covr Pl top 01 & [ Cover

objects and use B3, ordouble-cickan object

Figure 15-53 The placement of ejector pin
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Ejector Pin Post Processing
Ribbon:  Mold Wizard > Main Gallery > Ejector Pin Post Processing

@ This tool helps you to trim the ejector pin. To trim the ejector pin, choose the Ejector

Pin Post Processing tool from the Main gallery of the Mold Wizard tab; the Ejector Pin

Post Processing dialog box will be displayed, refer to Figure 15-54. Also, you prompted

to select the target ejector pins. Select the ejector pins that you need to trim and then choose
the OK button; the pins will be trimmed and the dialog box will be closed.

£} Ejector Pin Post Processing O X

Type A
g Trim v
Target A

Part Mame Count  Status

£ >
% Select Ejectors (0] (}
Tool A
Trim Part Cover_Plastic_trim_02, =
Trirn Surface CORE_TRIM_SHEET -

-
Cancel

Figure 15-54 The Ejector Pin Post Processing dialog box
Sub-Insert Library
Ribbon:  Mold Wizard > Main Gallery > Sub-Insert Library

Z% This tool helps you to create and insert those components that go through wear and tear

regularly or need regular replacement. Generally, the material of the insert is P20 or
H13. To create the sub-insert in the core and cavity, choose the Sub-insert Library tool from
the Main gallery of the Mold Wizard tab; the Sub-insert Design dialog box with the Information
window will be displayed, refer to Figures 15-55 and 15-56. Specify whether you need CORE
SUB INSERT or CAVITY SUB INSERT from the Member Select area of the Reuse Library
navigator and then specify the parameters of the insert from the Details rollout of the dialog
box. Choose the OK button to close the dialog box; the Point dialog box will be displayed.
Specify the parameter in dialog box and then choose the OK button. Choose the Cancel button
to close the dialog box.
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Design dialog box
Pocket
Ribbon:  Mold Wizard > Main Gallery > Pocket © Pocket 0 X
- This tool helps you to create pocket in the mold plates and rim 7 "
@ inserts. To create a pocket, choose the Pocket tool from the ~ * et °|

Main gallery of the Mold Wizard tab; the Pocket dialog — Treet A
box will be displayed, refer to Figure 15-57. Also, you are % selectBody() @
prompted to select the target bodies, select the required mold N
plates or insert. By default, the Subtract Material option is

. . . 00 e omponen i
selected in the Mode rollout of the dialog box. After selecting " .
. . ¥ Select Object (0]
the body, click the Select Object area of the Tool rollout. Select e
. . . Reference Set

the tool parts that are to be subtracted like ejector pin and then
choose the Apply button from the dialog box. Repeat this step = ™°¢ ~
until the required subtraction has been done. Choose the OK i
button to close the dialog box. Check Pocket Status
View Manager T
Ribbon:  Mold Wizard > Main Gallery > View Manager Settings v

This tool helps you to manage the display of the mold
model components. As you choose this tool, the View
Manager navigator will be displayed, refer to Figure 15-58. The
functioning of this navigator is similar to assembly navigator.

Figure 15-57 The Pocket
dialog box

H Cancel |
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Figure 15-58 The View Manager navigator
Cooling

Cooling is a process required to cool the component. The cycle time of cooling plays an important
role in mold costing. NX provides you the Cooling Tools gallery in which all the tools related
to cooling are available. The procedure to create cooling channel are discussed next.

Pattern Channel
Ribbon:  Mold Wizard > Cooling Tools Gallery > Pattern Channel

This tool is used to create the cooling channels using sketches or curves. To create a
ﬁ% channel, choose the Pattern Channel tool from the Cooling Tools gallery of the Mold

Wizard tab; the Pattern Channel dialog box will be displayed, refer to Figure 15-59. Also,
you will be prompted to create the sketch or select the section geometry. After creating the
sketch, specify the channel diameter in the Setting rollout and then choose the OK button from
the dialog box.

&} Pattern Channel O X
Channel Path A
¥ Select Curve (0) ,rg
Settings A
Channel Diameter mm v
Diameter List 10 -
Preview Show Result )

-

o [ oot | ]

Figure 15-59 The Pattern Channel dialog box
Direct Channel
Ribbon:  Mold Wizard > Cooling Tools Gallery > Direct Channel

This tool is used to create the cooling channel or baffle by specifying a specified point.
6;9 To create a channel, choose the Direct Channel tool from the Cooling Tools gallery of
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the Mold Wizard tab; the Direct Channel dialog box will be displayed, refer to Figure 15-60.
Also, you will be prompted to select infer point. Select the start point of the channel. Next, select
the Distance option from the Motion drop-down list of the Channel Extrusion rollout; you will
be prompted to specify the vector direction and then enter the length of the channel in the
Distance edit box. Choose the OK button to close the dialog box.

£} Direct Channel o X
Attribute Type A
’ Channel -
Channel Location A
¥ Specify Point Gt }5. -
Boundary Body A
Select Body (0) R
Channel Extrusion A
Motion B Dynamic -
Specify Orientation Q:

[] Move Handles Only
Extension [&) Mone -
Settings A

[] Remave Parameters
[] Adjust Boundary Tip End
Tip End
® None (O Angle (O Round

Channel Diameter 10 mm -
Diameter List 10 -
Preview Show Result -

Cancel

Figure 15-60 The Direct Channel dialog box

Extend Channel
Ribbon:  Mold Wizard > Cooling Tools Gallery > Extend Channel

This tool is used to extend the length of the cooling channel. To extend the length,
6:? choose the Extend Channel tool from the Cooling Tools gallery of the Mold Wizard

tab; the Extend Channel dialog box will be displayed, refer to Figure 15-61, and you
will be prompted to select the cooling channel. Select the cooling channel and specify the length
of the cooling channel in the Distance edit box. Choose the OK button; the length will be
extended and the dialog box will be closed.
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£} Extend Channel

Channel

¢
X

¥ Select Channel (0)

Reverse Direction
Limits

Select Boundary Solid (0]

@I xKQ .

Distance |m mm

4

Settings

>

[ Remove Parameters

Tip End
® None (O Angle O Round

Show Result .

-

| || || Cancel |

Figure 15-61 The Extend Channel dialog box
Connect Channels
Ribbon:  Mold Wizard > Cooling Tools Gallery > Connect Channels

This tool is used to connect the cooling channel. To do so, choose the Connect Channels

‘f tool from the Cooling Tools gallery of the Mold Wizard tab; the Connect Channels dialog

box will be displayed, refer to Figure 15-62. Also, you will be prompted to select the first

cooling channel. Select the first cooling channel; you will be prompted to select the second

cooling channel. Select the second cooling channel and then choose the OK button to close the
dialog box.

£} Connect Channels O X

First Channel A

4 Select Channel (0)

Second Channel A
¥ Select Channel (0) E
Vector A
[ start Peint

[] Projection Distance

Show Result

-

| || || Cancel |

Figure 15-62 The Connect Channels dialog box
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Adjust Channel
Ribbon:  Mold Wizard > Cooling Tools Gallery > Adjust Channel

This tool is used to adjust the position of the cooling channel. To do so, choose the Adjust
Gﬁ Channel tool from the Cooling Tools gallery of the Mold Wizard tab; the Adjust Channel

dialog box will be displayed, refer to Figure 15-63. Also, you will be prompted to select
the cooling channel. Select the cooling channel which you want to adjust; a dynamic triad will
be displayed on the channel. Move the channel by using handles and angular handles of the
triad. After positioning the channel, choose the OK button to close the dialog box.

{3 Adjust Channel O X

Type A
Adjust Channel [ Channel Repositio
Channel A
% Select Channel (0) ")
Faces A
Select Face () ﬁ:),I
Maovement A
Direction Along Vector -
Specify Vector Wl Tjﬁ -
Setting A
Distance m mm -
Preview Show Result /,-.
hd
Cancel

Figure 15-63 The Adjust Channel dialog box
Cooling Fittings
Ribbon:  Mold Wizard > Cooling Tools Gallery > Cooling Fittings

This tool is used to add cooling fitting components to cooling channels. To add the

@ components, choose the Cooling Fittings tool from the Cooling Tools gallery of the

Mold Wizard tab; the Cooling Fittings dialog box will be displayed, refer to Figure 15-64,

and you will be prompted to select the channel. Select the cooling channel and then choose the

OK button; the dialog box will be closed and you will notice the o-rings in the mold cooling
channel.
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{3} Cooling Fittings O X

Channel A

% Select channel (0)

Specify Point .y
Boundary Body A
[ Auto Search Boundary Bodies
Select Body (0) e
Fitting Point A
MName Type
< >
Settings v
Cancel

Figure 15-64 The Cooling Fittings dialog box

Assembly Drawings
Ribbon:  Mold Wizard > Mold Drawing Gallery > Assembly Drawing

—— This tool helps you to create the drawing of the mold assembly. To create the drawing,
=1 choose the Assembly Drawing tool from the Mold Drawing gallery of the Mold Wizard
tab; the Assembly Drawing dialog box will be displayed, refer to Figure 15-65. By default,
the Visibility option is selected in the Type rollout. This option helps you to select the parts of
the mold you want to show in the drawing. Select the component from the drawing area and
then select the Drawing option from the drop-down list of the Type rollout. Select the Self
Contained drawing type from the Drawing Type rollout and select the type of template from
the Templates rollout. Choose the Apply button. Select the View option from the drop-down
list of the Type rollout and then select the predefined views from the View Control rollout.
Specify the scale value in the Scale edit box of the View Control rollout. Choose the OK button
to close the dialog box.
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£} Assembly Drawing O X
i Visibility -
Attribute Assignment A
Attribute Name MW _SIDE -
Attribute Value A -

[ Only Show Components with Attribute
[] Blank Components with Attribute
[ List Dependents

+/ Select Component (23) -$—
Compenent Mame Filter -

Mame Type
Cover_Plastic_cavity_023 o CAVITY -~

Cover_Plastic_prod_side ...
Cover_Plastic_prod_side_..
Cover_Plastic_cavity_023 i CAVITY
Cover_Plastic_prod_side_...
Cover_Plastic_cavity_023 i CAVITY
Cover_Plastic_prod_side_...
Cover_Plastic_cavity_023 i CAVITY
Cover_Plastic_misc_side_...
Cover_Plastic DHR21_076 . LOCA...
Cover_Plastic_shcs DHRZ.. + SCREW
Cover_Plastic_shcs_DHRZ... : SCREW
Cover_Plastic_Sprue Bush... . SPRUE

Cover_Plastic_cool_side_... W

-

Apply Cancel
Figure 15-65 The Assembly Drawing dialog box

Component Drawing
Ribbon:  Mold Wizard > Mold Drawing Gallery > Component Drawing

This tool helps you to create and manage the drawing for components of the mold
= assembly. To create a drawing, choose the Component Drawing tool from the Mold
Drawing gallery of the Mold Wizard tab; the Component Drawing dialog box will be
displayed, refer to Figure 15-66. Select the component from the list in the Drawing rollout and
then choose the Create Drawing button from the Create Drawing area of the Drawing rollout;
the drawing will be generated.
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£} Component Drawing QX

Drawing A

@®:Create Drawing. () Update Drawing

Companent Type | All -
Select Component (0) -~
Name Drawing File Sheet Template Type

Cover_Plasti... Cover_Plastic_l.. Sheet1 template_a0_comp... ~
Cover_Plasti... Cover_Plastic_p... Sheet1 template_a0_comp...

Cover Plasti... Cover Plastic_tr... Sheet 1 template_al_comp...

Cover_Plasti... Cover_Plastic_c... Sheet1 template_a0_comp... CAVITY

Cover Plasti.. Cover Plastic_c.. Sheet1 template_a0_comp... CORE

Cover Plasti... Cover Plastic_p... Sheet 1 template_a0_comp...

Cover_Plasti.. Cover_Plastic_.. Sheet1 template_al_comp...

Cover Plasti.. Cover Plastic s.. Sheet1 template_a0_comp...

Cover_Plasti... Cover_Plastic_p... Sheet 1 template_a0_comp...

Cover_Plastic Cover_Plastic_d... Sheet1 template_al_comp...

Cover Plasti... Cover Plastic .. Sheet 1 template_al_comp...

Cover_Plasti... Cover_Plastic_p... Sheet1 template_a0_comp...

Cover_Plasti... Cover_Plastic_p... Sheet1 template_a0_comp...

Cover_Plasti... Cover_Plastic_b... Sheet1 template_al_comp...

Fover Dlacki  Couer Dlackic A Shaot 1 tarmnlate 3N camn e
Create Drawing )
Templates A
Templste | template_a0_comp_mm.prt -

[ ciose |
Figure 15-66 The Component Drawing dialog box

TUTORIAL

To perform the tutorial you need to download the zipped file named asc15_NX_2019_input from
the Input Files section of the CADCIM website. The complete path for downloading the file is:

Textbooks > CAD/CAM > NX > Siemens NX 2019 for Designers > Input Files

After the file is downloaded, extract the folder to the location C:\NX 2019\ and rename itascl5.

Tutorial 1

In this tutorial, you will create mold design of the plastic cover part which is shown in Figure 15-67.
Here, you will analyze the model and add mold base to it. Also you will create core and cavity,
runner and gate, and add lifter, ejector pin, and cooling channels to the model.

After creating the mold design, save the mold design with the name ¢15tutl.prt at the location
given below:
INX\c15 (Expected time: 3 hr)
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cpg AT TR an TR

Figure 15-67 Plastic part for Tutorial 1

The following steps are required to complete this tutorial:

Start NX and open the model, refer to Figure 15-68.

Create gate for analyzing the model, refer to Figures 15-74 and 15-75.
Create runner and sprue for analyzing the model, refer to Figure 15-77.
Set Parting direction.

Start analysis and analyze the result, refer to Figures 15-85 through 15-90.
Initialize the project.

Orient the model, refer to Figures 15-94 and 15-95.

Create Parting surface, refer to Figures 15-99 through 15-103.

Create Core and Cavity, refer to Figures 15-110 and 15-111.

Add Mold Base, refer to Figure 15-113.

Add lifter for ejection and part shape, refer to Figure 15-116.

Add Register ring and sprue bush in mold, refer to Figures 15-118 through 15-120.

. Add Ejector Pin for ejection of component, refer to Figure 15-124.

Create gate and runner, refer to Figures 15-129 and 15-130.
Create cooling channel for cooling the component, refer to Figure 15-133.

Starting NX and Opening a Model

First, you need to start NX and then open a new file.

1.

2.

Double-click on NX shortcut icon on the desktop of your computer to start NX.

~2

Choose the Open button from the Standard group of the Home tab or choose :_I
Menu > File > Open from the Top Border Bar; the Open dialog box is displayed. ~ ©Pen

Select Cover_Plastic.prt from the Name list; Cover_Plastic.prt is displayed in the File name
drop-down list. Then choose the OK button; the model is displayed, refer to Figure 15-68.
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Figure 15-68 Plastic part in Modeling environment

Analyzing Model by Easy Fill Advanced
Now, use the tools in the Easy Fill Advanced tab for analyzing the model. Itis a continuation
process; if material does not fill properly then you need to do more and more iterations by
changing gate, runner, coolant size, shape, or orientation.

1. Click on the Easy Fill Advanced tab and choose the Set Working Folder tool from g
the Setting group of the tab; the Working Folder dialog box is displayed. set Working

Folder

2. Choose the Browse button; the Open dialog box is displayed where you can set the working
folder, refer to Figure 15-69.

& Open X

Lookin: [ | mold - @@
+ Name Date modified Type Size

Cover_Plastic 8/3/20195:53 AM  File folder
Quick access

Desktop

Libraries

=
This PC

@

Network

Directory: ruscﬂm\d5_nx_2019\C15_NX_2019_\nput\mu\d\ 0K

Files of type: |Directores = Cancel

Figure 15-69 The Open dialog box
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Note
If the Easy Fill Advanced message box appears after choosing the Set Working Folder tool then
choose the Yes button to close this message box.

3. Choose the OK button from the Open dialog box and then from the Working Folder dialog
box.

Creating Gate for Analyzing Model

To analyze the model you are going to create gate.

1. Choose the Set Cavity tool from the Setting group of the Easy Fill Advanced tab in the
Ribbon; the Select Cavity dialog box is displayed, refer to Figure 15-70.

Cavity Setting A
% Select Body (0) @
Material Setting A
Material

™

Cancel
Figure 15-70 The Select Cavity dialog box

2. Select solid body from the Select Body area of the Cavity Setting rollout to specify solid
body as cavity.

3. Choose the Push button to select material button in the Material Setting rollout; the
Moldex3D Material Wizard dialog box is displayed, refer to Figure 15-71.

@ Moldex3D Material Wizard >
Material: I»"—'\BS =l
Producer: IJ'—\. Schulman j

Grade Name:  [POLYFLAM RABS 90000 UVE ~|

o

Figure 15-71 The Moldex3D Material Wizard dialog box

4. Select ABS+PA6 from the Material drop-down list if not already selected.
5. Select Styrolution from the Producer drop-down list if not already selected.

6. Select Terblend N NG-06 from the Grade Name drop-down list.
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7. Choose the OK button from the Moldex3D Material Wizard and then choose the OK button
from the Select Cavity dialog box.

8. Choose the Gate Wizard tool from the Wizard group; the Create Gate dialog box is displayed,
refer to Figure 15-72.

9. Select Edge Gate from the Type of gate drop-down list to select the type of gate.
10. Select Cold Runner Gate from the Attribute drop-down list if not already selected.

11. Choose the Point Dialog button; the Point dialog box is displayed, refer to Figure 15-73.

£} Create Gate O X

Position of Gate A
A +
% Select Point (0) -+ e 5
Attribute N ‘ # Inferred Point v|
Type of gate | Pin Gate - |
i i A
Attribute | Cold Runner Gate - | Point Location
Select Object
Cross-Section Parameters A V/ Sele ject (0) -q}
Output Coordinates A
D2
40 Reference | Absclute - Work Part + |
) x | EE - |
¥ | 0.0000000000 mm v |
— z | 0.0000000000 mm  ~|
D1
= Offset A
D1 D2 G.0000 1
Gate length(L) £.0000 2 Offset Option None -
- -
| | | concel | [ ok
Figure 15-72 The Create Gate dialog box Figure 15-73 The Point dialog box
g g g

12. Select the Point on Face option from the Type drop-down list; you are prompted to select
face at point location, refer to Figure 15-74, for face selection.

13. Enter 0.308 and 0.5 in the U Parameter and V Parameter edit boxes respectively, of the
Location on Face rollout and choose the OK button from the Point dialog box to exit the
dialog box.

14. Enter 90 and 5 in the Angle and Gate length(L) edit boxes respectively, of the Cross-Section
Parameters rollout.

15. Choose the OK button to close the Create Gate dialog box. Refer to Figure 15-75 for model
with gate.
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Figure 15-75 The model with Fan gate

Creating Runner and Sprue for Analyzing Model
To analyze the model, you are going to create runner and sprue.

1. Choose the Runner Wizard tool from the Wizard group; the Runner Wizard ﬁ
dialog box is displayed, refer to Figure 15-76.

Runner
Wizard
By default, the Mold Setting tab is selected.

2. Select - Z-Axis from the Parting Direction drop-down list, 2-Plate mold from the Mold
Plate Type drop-down list, and Cold Runner from the Runner Attribute drop-down list.

3. Choose the Sprue Setting tab and enter 6, 3, and 45 in the D1, D2, and SH edit boxes
respectively, of the Sprue Geometry Parameters rollout.
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£} Runner Wizard 2 X

Sprue Setting  Runner setting

Parting Direction - L-Pxis -

Mold Plate Type 2-Plate mold A

Runner Attribute Cold Runner - |

Parting Plane Position A
Gate plane

Fart

Figure 15-76 The Runner Wizard dialog box

4. Choose the Runner setting tab and then select the Circular type of cross section for runner
from the Type drop-down list and enter 6 in the D edit box.

5. Choose the OK button to close this dialog box.

6. The gate, runner, and sprue are now attached to the model, refer to Figure 15-77.

Melt Enterance

Sprue
Component e —

/ Runne\

Figure 15-77 The Runner and Sprue with model

Setting the Parting Direction

To analyze the model, you are going to set the direction of ejection.

1. Choose the Set Parting Direction tool from the Setting group to set the parting direction
of the model; the vector dialog box is displayed, refer to Figure 15-78.
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15-48
£} Vector O X
2§ -ZC-ais P v
Vector Orientation
Reverse Direction X

-

Figure 15-78 The Vector dialog box

2. Select the ZC-Axis option from the Type rollout if not already selected and choose the OK

button to close the dialog box.

Starting Analysis and Analyzing the Resuit

The Start Analysis and Show Result tools help to analyze and show results.

1. Choose the Start Analysis tool from the Setting group to

start the analysis of the model; the Analysis Setup dialog
box is displayed, refer to Figure 15-79.

2. Select the Filling & Packing - F P option from the Analysis
drop-down list of the Analysis Set rollout.

3. Enter 220, 0.25, 4.20, 250 and 60 in the Maximum injection
pressure, Filling time, Packing time, Melt Temperature, and
Mold Temperature edit boxes respectively, of the Process
Condition rollout.

4. Choose the OK button; the dialog box closes and the
Moldex3D window showing the solid mesh generation
process gets displayed, refer to Figure 15-80.

Note that after the solid mesh is created then the Moldex3D
SYNC Project Monitor window showing filling and packing
analysis progression is displayed, refer to Figure 15-81. After
the completion of analysis, the Moldex3D eDesignSYNC
window gets displayed, refer to Figure 15-82.

Analysis Set A
Remark Funi

Analysis Filling - F -
Process Condition A
Max. Injection Pressure (MPa) 250.0000
Filling time (sec.) 1.2700
Melt Termperature (*C) 2g0.0000
Mold Temperature (*C) eD.0000
Mesh A
Meshing Size 1.4900
Computing Setting A

No. task 8 -
Start Analysis Immediately

-

“ )

Figure 15-79 The Analysis
Setup dialog box

5. Choose the OK button from the Moldex3D eDesignSYNC window and the Close button

in the Moldex3D Project Monitor window.
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Moldex3D *

| Create solid mesh [ ]
¥ Prepare data

¥ Create solid mesh
[T Paste boundary condition

[T Export mesh fila

Figure 15-80 The Moldex3D window

Moldex3D SYNC Project Monitor [Cover_Plastic] — >
Run | Analysis | Progress | Remaining Ti... | status
Run1 Filling 5.0 % —laeml- RUNNING
Run1 Packing 0.0 % [ - PENDING
Information *
{C) 1995-2819 CoreTech System Co., Ltd. All rights ~
reserved .

»»> Analysis start time: Wed Jul 24 B5:46:26 2619

»»> Writing polyhedral mesh file completed?...

L

Remove Start || Stop || Close

Figure 15-81 The Moldex3D SYNC Project Monitor window

Moldex3D eDesignSYNC *

:I All tasks have been completed

Figure 15-82 The Moldex3D eDesignSYNC Window

6. Choose the Show Result tool from the Setting group; the Show Result dialog box gets
displayed, refer to Figure 15-83.



15-50 Siemens NX 2019 for Designers

£} Show Result O X
Analysis Result A
Run3 4
Description

| |
Close

Figure 15-83 The Show Result dialog box

7. Select result from the Analysis Result rollout; the dialog box gets modified, refer to

Figure 15-84.

Analysis Result A

R

Description

Run3 |
Display Result A
Criteria | Mene hd ||E
Display Mode Classic Mode -
Analysis Filling -
Result Type | Melt Front Tirme - |
] ®¥ Plot
Result Adviser
Display Setting

Animation Setting
Views Tool
Save Animation as Files

Generate Report

< < < < < <

Export Result to Moldex3D Viewer

h
Close

Figure 15-84 The modified Show Result dialog box

8. You can select the Filling or Packing option from the Analysis drop-down list in the Display
Result rollout. By default, the Filling option is selected.
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10.

11.

In this tutorial, you can visualize the results by selecting appropriate option from the Result
Type drop-down list.

The options which can be selected for results are Melt Front Time, Air Trap, Weld Line,
Volumetric Shrinkage, Maximum Shear Stress, and Temperature.

Select the XY Plot check box to activate the XY Curve Type drop-down list. Next, select the
Sprue Pressure or Clamping Force option from this drop-down list; the resultant graphs
are shown, refer to Figure 15-85 through Figure 15-90.

M poiosy g Spue Pressure

Mea (000 17050) Fiing Spue Presse

wepocves) e Spue Pressare

16000 —

Figure 15-87 The Sprue Pressure vs Weld Line graph
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Figure 15-90 The Clamping Force vs Temperature graph

12. Choose the Play button from the Animation Setting rollout. Next, choose the Close button
to close the dialog box.

13. Save the file to the specified folder by choosing the Save All button and closing NX.

Next, you need to open the model again. To open a file, choose the Open button from the
Standard group of the Home tab or choose Menu > File > Open from the Top Border Bar;
the Open dialog box is displayed. Select Cover_Plastic.prt from the Name list; Cover_Plastic
gets displayed in the File name drop-down list. Then choose the OK button; the model is
displayed.
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Initializing the Project from Mold Wizard Tab
Now use the Initialize Project tool to define the pryemrm—"m"" O X
material and the path for saving the project.

Project Settings A
1. Choose the Mold Wizard tab. Path

F\Fovork_2019NX_1847MManuscripthcl5_nx

2. Choose the Initialize Project tool from the Mold  Name
Wizard tab; the Initialize Project dialog box is Caver Plastic
displayed, as shown in Figure 15-91.

Material NYLOMN -
Shrink 1.016
3. Choose the Browse button from the Path area of e
the Project Settings rollout; the Open dialog box Configuration Mold.v1 -
is displayed, as shown in Figure 15-92. After setting .
the path of the project, choose the OK button to “ -

close the dialog box.

Figure 15-91 The Initialize Project

4. Select the Nylon material from the Material ;
dialog box

drop-down list; the Shrinkage edit box gets
updated automatically depending upon the type of selection of material. Next, select the
desired template from the Configuration drop-down list. By default, the Mold.V1 template
is selected. Choose the OK button to close the dialog box.

& Open X

Lock in: I mold j - £ B

* Mame Date medified Type Size

Cover_Plastic £8/3/2019 5:53 AM File folder
Quick access

Desktop

m
Libraries
This PC

Network

Directory: I1uscriut\c1 5_rx_2019\C15_NX_2019_input\mold\|

I

Files of type: IDirectones ;I Cancel
Figure 15-92 The Open dialog box

Reorienting the Model
Now use the Mold CSYS tool to reorient the model.
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1. Choose the Mold CSYS tool from the Main group of the Mold Wizard tab; the Mold LZ:
CSYS dialog box is displayed, as shown in Figure 15-93; you are prompted to
double-click on WCS.

¥ Mold CSYS O X

Change Product Position A

() Center of Selected Faces

Lock XYZ Position A

[ Lock X Position
[1 Lock ¥ Position
Lock Z Pasition

-

= o [RTR T
Figure 15-93 The Mold CSYS dialog box

2. Double-click the WCS, refer to Figure 15-94; you are prompted to drag a handle or select
a handle. Select the handle of WCS; the WCS Dynamics dialog box is displayed.

WCS

Figure 15-94 The WCS (work coordinate system)
3. Position the WCS as shown in Figure 15-95.

Figure 15-95 The WCS after positioning
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4. Click the middle mouse button to close the WCS Dynamics dialog box.

5. Select the Product Body Center radio button from the Change Product Position rollout of
the Mold CSYS dialog box. Next, choose the OK button from the Mold CSYS dialog box
to close the dialog box.

Check Regions

You can use the Check Regions tool to check regions of core and cavity.

1. Invoke the Check Regions tool from the Parting Tools gallery; the Check Regions /|
dialog box with the Parting Navigator window is displayed, refer to Figure 15-96.

£} Check Regions 9 X

Calculate | Face  Region  Information

Froduct Body end irecten "

+/ Select Product Body (1) Parting Objects i G |

-3 Parting Design
+/ Specify Draw Direction W T - -
X }5 +$ Product Body 1 1
Calculate A +|:|"" Workpiece 1 20
; e | Workpiece Wireframe
Option : I:‘

®) Keep Existing ?

(O Edit Regions Only |:| N

O Reset Al -0
o D“E‘)

Calculate = gﬁ
0@
H i
[l
+-[Ji# Cavity
+- DL{; Core

Cancel

Figure 15-96 The Check Regions dialog box with the Parting Navigator tree

2. Choose the Calculate button from the Calculate rollout of the Calculate tab and then choose
the Region tab. Choose the Set Regions Color button from the Define Regions rollout.

Note, the color of the model gets changed. These color represent core, cavity, and undefined
region in the model.

3. The Cavity Region radio button is selected by default in the Assign to Region rollout. Select
the undefined region (back face) of the model and then choose the Apply button. Select the
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Core Region radio button and select the undefined region (front face) of the model and
then choose the Apply button; the undefined regions gets the color of the core and cavity
region.

4. Choose the OK button to close the dialog box and close the Parting Navigator window.
Modified model after using the Check Region tool, is shown in Figure 15-97.

Figure 15-97 The modified model after using the Check Region tool

Creating Core and Cavity Region Sheets

To create parting lines, core, and cavity regions, you need to use the Define Regions tool.

1. Choose the Define Regions tool from the Parting Tools gallery of the Mold Wizard J=1
tab; the Define Regions dialog box is displayed, refer to Figure 15-98.

2. Select Cavity region in the Define Regions rollout and then select Create Regions and the
Create Parting Lines check boxes from the Settings rollout.

3. Choose the Apply button; a green tick mark appears beside the cavity and core region.
4. Choose the Cancel button to close the Define Regions dialog box.

Refer to Figure 15-99 for the parting lines.
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Figure 15-98 The Define Regions dialog box

‘\_.--”Ff;

Figure 15-99 Parting lines of the component

Creating Parting Surface
To create parting surface, you need to use the Design Parting Surface tool.

1. Choose the Design Parting Surface tool from the Parting Tools gallery of the Mold Wizard
tab; the Design Parting Surface dialog box is displayed, refer to Figure 15-100.

2. Choose the Guided Extension button from the Method area of the Create Parting Surface
rollout.
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Figure 15-100 The Design Parting Surface dialog box

3. Expand the Edit Parting Segments rollout and choose the Edit Guide Lines button; the
Guide Line dialog box is displayed. Enter 200 in the Guide Line Length edit box. Next,
select the parting line; guide line is created, refer to Figure 15-101. Similarly, create other
guide lines, refer to Figure 15-102. Choose the OK button from the Guide Line dialog box;
the Design Parting Surface dialog box is displayed.

Guide Line Length 100 =

Figure 15-101 The guide line created



Introduction to Injection Mold Design 15-59

Guide Line Length| 200+

Figure 15-102 The guide lines created

4. Select Segment 1 from the Parting Segments sub-rollout of the Parting Lines rollout. Next,
choose the Swept button from the Method area of the Create Parting Surface rollout. Specify
first and second direction. Enter 250 as the value in the Extend Distance dynamic edit box
and choose the Apply button. Similarly, create parting surface for rest of the portion of the
part, refer to Figure 15-103.

5. Choose the Cancel button to close the dialog box and the Save All button to save the file.

Figure 15-103 Parting surface of the component

Creating Workpiece
The Workpiece tool helps you to decide the size of the core and cavity insert.

1. Choose the Workpiece tool from the Main gallery of the Mold Wizard tab; the New Iray+
Ray Traced Studio Rendering window is displayed. Choose the OK button, the Workpiece
dialog box is displayed, refer to Figure 15-104. By default, the Product Workpiece option
is selected in the Type drop-down list and the User Defined Block option is selected in the
Workpiece Method drop-down list. Refer to Figure 15-105 for core and cavity insert size.
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Figure 15-104 The Workpiece Figure 15-105 The Core and Cavily insert
dialog box

Note, the size of insert is automatically defined. Choose the OK button to exit the Workpiece
dialog box.

Creating Layouts of the Workpiece
Now, use Cavity Layout tool to create the layout of the core and cavity insert.

1. Choose the Cavity Layout tool from the Main gallery of the Mold Wizard tab; the Cavity
Layout dialog box is displayed, refer to Figure 15-106. The body of the core and cavity is
automatically selected and a green tick mark becomes visible in the Select Body area of the
Product rollout.

2. Enter 4 in the Cavity Count edit box of the Balanced Layout Settings rollout.
3. Click in the Specify Vector area of the Layout Type rollout and select -XC-axis from the
Inferred Vector drop-down list. Choose the Start Layout button from the Generate Layout

rollout; the layout gets created, refer to Figure 15-107.

4. Choose the Auto Center button from the Edit Layout rollout to center the layout with mold
base center.
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Figure 15-106 The Cavity Layout dialog box
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Figure 15-107 The cavity layout of the workpiece

5. Choose the Edit Insert Pocket button from the Edit Layout rollout; the Insert Pocket dialog
box is displayed, refer to Figure 15-108.
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Figure 15-108 The Insert Pocket dialog box

6. Select 5 from the R drop-down list and 2 from the type drop-down list. Next, choose the
OK button to close the dialog box.

7. Choose the Close button to close the Cavity Layout dialog box.

Creating Core and Cavity
Now, use the Define Cavity and Core tool to create the core and cavity.

1. Choose the Define Cavity and Core tool from the Parting Tools gallery of the Mold
Wizard tab; the Define Cavity and Core dialog box is displayed, refer to Figure 15-109. ===
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Figure 15-109 The Define Cavity and Core dialog box

By default, the Region option is selected in the Type drop-down list and the Cavity region
is highlighted in the Select Sheets rollout.

2. Choose the Apply button, the New Iray + Ray Traced Studio Rendering window is displayed.
Choose the OK button; the View Parting Result dialog box and the cavity of the model get
displayed, refer to Figure 15-110. Choose the Reverse Direction button to create other half
of the cavity. Choose the OK button to close the dialog box; a green tick mark is displayed
in front of Cavity region in the Select Sheets rollout of the dialog box. Now, select Core
region in the Select Sheets rollout of the dialog box and repeat the same procedure as for
the cavity; the core gets displayed, refer to Figure 15-111.

3. Choose the Cancel button to close the dialog box.
4. Select Cover_Plastic_parting_xxx in the assembly navigator and right-click on it; a shortcut

menu is displayed. Choose Cover_Plastic_top_xxx from the Open Parent in Window
drop-down list in the shortcut menu.
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Figure 15-110 The View Parting Result dialog box and cavity of the model on screen

Figure 15-111 The core of the model

Adding Mold Assembly
Now, use the Mold Base Library tool to create the plates for the mold assembly.

1. Choose Mold Base Library tool from the Main gallery of the Mold Wizard tab; the Mold
Base Library dialog box, refer to Figure 15-112 and the Information window is displayed.

2. Select 5050, 2, 106, 36, and 106 from the index, TCP_type, AP_h, BP_h, and CP_h
drop-down lists respectively in the Details rollout. Next, choose the OK button to close the
dialog box; the Mold plates are added to the assembly, refer to Figure 15-113.
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Figure 15-112 The Mold Base Library Figure 15-113 The Mold Plate assembly
dialog box

3. Choose File > Save > Save All to save the file.

Adding Lifter in Mold Assembly

Now, use the Slide and Lifter Library tool to create the lifter for mold assembly.

1. Choose the Slide and Lifter Library tool from the Main gallery; the Slide and Lifter GJE
Design dialog box is displayed with the Information window.

2. Choose Lifter folder in Main Panel and Dowel Lifter in the Member Select panel of the
Reuse Library; the Slide and Lifter Design dialog box gets modified with the Information
window, refer to Figure 15-114.
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Figure 15-114 The Slide and Lifter Design dialog box and the Information window
3. Specify the parameter of the Lifter in the Details rollout and

choose the Apply button.

4. You can position the lifter to place it in a correct way. Choose
the Select Standard Part area of the Part rollout and then
select the lifter which you want to place.

5. Choose the Reposition button in the Part rollout, the Move
Component dialog box is displayed, refer to Figure 15-115.

Components to Move

/" Select Components (1)

Transform A
Motion B¢ Dynamic -

/" Specify Orientation

[ Move Handles Only

-
o [T

6. You can place the lifter position using this dialog box, choose  Figure 15-115 The Move
the OK button after placing the lifter to close the dialog box.  Component dialog box

7. Choose the OK button to close the Slide and Lifter Design dialog box. Refer to Figure 15-116
for arrangement of lifter and repeat the same procedure for other lifters.

~—~ Note
@‘ If you create lifter for one component then other lifters automatically will be placed.
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Figure 15-116 The arrangement of lifier

Trimming the Lifters
Now, trim extra part of the lifters.

1. Choose the Trim Mold Components tool from the Mold Tools gallery of the Mold Wizard
tab; the Trim Mold Components dialog box will be displayed, as shown in Figure 15-117.

2. Select the lifters from the mold assembly and choose the OK button to trim the lifters. Refer
to Figure 15-118 for the modified lifters.

€} Trim Mold Components O X
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I'g Trim - |
Target A
% Select Body (0) P
Tool A

Trim Part Cover_Plastic_trim_02, «
Trim Surface CORE_TRIM_SHEET -
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| 0K | | Applh | | Cancel |
Figure 15-117 The Trim Mold Figure 15-118 Modified lifters

Components dialog box



15-68 Siemens NX 2019 for Designers

Adding Register Ring to the Mold Assembly
Now, add Register ring in the mold assembly.

1. Choose MW Standard Part Library from the Reuse Library. Expand the MW Standard Part
Library and then choose the type of locating ring from the Injection folder of DME_MM
Standard.

2. Double-click on the Locating_Ring With_Mounting_Holes[DHR21] from the Member
Select panel, the Standard Part Management dialog box is displayed with the Information
window, refer to Figure 15-119.
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Figure 15-119 The Standard Part Management dialog box and the Information window

3. Select M8 and 12 in the Type and H drop-down lists. Enter 100 in the D edit box of the
Details rollout and then choose the OK button; the Information window and the Standard
Part Management dialog box is closed. Another Information window is displayed; choose
the Close button to close the window. Refer to Figure 15-120 for arrangement of Register
ring.
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Register Ring

Figure 15-120 The arrangement of Register ring in the Mold assembly

Adding Sprue Bush in the Mold Assembly
This tool helps you to add the sprue bush to the mold assembly. Sprue bush helps to connect
the molten flow channel between runner and Register ring.

1. Choose the MW Standard Part Library from the Reuse Library. Expand the MW Standard
Part Library and then choose type of sprue bush from the Injection folder of DME_MM
Standard.

2. Double-click on the Sprue Bushing(DHR74) from the Member Select panel; the
Standard Part Management dialog box is displayed with the Information window, refer to
Figure 15-121.

3. Enter 18, 4, 116, 36, and 24 in the D, O, N, H, and K edit boxes respectively, of the Details
rollout.

If the size of sprue bush is not appropriate then you can change it by double-clicking on the
Sprue Bushing(DHR74) from the Member Select panel; the Standard Part Management
dialog box is displayed. Select the Select Standard Part area in the Part rollout and then
select the sprue bush in the mold assembly. Now, you can change the size parameters or
reposition the sprue bush. Refer to Figure 15-122 for arrangement of sprue bush in the
mold assembly.

4. Choose the OK button to close the dialog box.
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Figure 15-121 The Standard Part Management dialog box and the Information window

ometric

Figure 15-122 The arrangement of sprue bush in the Mold assembly
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Adding Ejector Pin in the Mold Assembly
This tool helps you to add Ejector Pin to the mold assembly. Ejector Pin helps you to eject
the component from the mold.

1. Choose MW Standard Part Library from the Reuse Library. Expand the MW Standard

Part Library and then choose type of ejector pin from the Ejection folder of the DME_MM
Standard.

2. Double-click on the Ejector Pin [Shouldered] from the Member Select panel, the
Standard Part Management dialog box is displayed with the Information window, refer to
Figure 15-123.
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Figure 15-123 The Standard Part Management dialog box and the Information window

3. Select 1 and 160 from the CATALOG_DIA and CATALOG_LENGTH drop-down lists in
the Details rollout. Choose the Apply button; the Point dialog box is displayed. Specify
the position of the ejector pin by placing the point. Choose the Cancel button to close the
dialog box. Next, choose the OK button to close the Standard Part Management dialog box
and the Information window. Refer to Figure 15-124 for the arrangement of ejector pin.
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Figure 15-124 The arrangement of ejector pin in the mold assembly

Trimming the Ejector Pin

This tool helps you to trim the ejector pin which is larger
in size.

Choose the Ejector Pin Post Processing tool from the
Main gallery of the Mold Wizard tab; the Ejector Pin Post
Processing dialog box is displayed, refer to Figure 15-125.

Select the ejector pins which need to be trimmed.

Choose the Apply button to trim the ejector pin. Choose
the Cancel button to close the dialog box.

Create Pocket

This tool helps you to create pocket for components to be
placed or moved.

Choose the Pocket tool from the Main gallery of the Mold
Wizard tab; the Pocket dialog box is displayed, refer to
Figure 15-126. You are prompted to select the target
bodies. Select the target bodies from the mold assembly.
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Figure 15-125 The Ejector Pin
Post Processing dialog box

Select the Select Object area in the Tool rollout, choose the tool body for which you need
to create pocket. Next, choose the Apply button to create pocket and the Cancel button to
close the dialog box. Refer to Figure 15-127 for pocket in the core plate.
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Figure 15-126 The Pocket dialog box Figure 15-127 The pocket in the core plate
Creating Gate

This tool helps you to create gate. Gate is a channel which directly connects runner and
part for molten flow of material.

1. Choose the Design Fill tool from the Main gallery of the Mold Wizard tab, the l'_af’-

Design Fill dialog box is displayed with the Information window, refer to &
Figure 15-128.

2. Select the type of gate from the Member Select panel in the Reuse Library. For this
component use Fan gate.

3. Specify the parameters of the gate in the Details rollout of the dialog box. Select the Select
Object area in the Placement rollout and specify gate position and orientation, refer to

Figure 15-129.

4. After placing the gate, choose the OK button to close the dialog box.
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Figure 15-128 The Design Fill dialog box and the Information window

Figure 15-129 The gate position and orientation in the model
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Creating Runner
This tool helps you to create runner. Runner is a channel which directly connects gate and
sprue bush for molten flow of material.

1. Choose the Design Fill tool from the Main gallery of the Mold Wizard tab, the l".-"i
Design Fill dialog box is displayed. =

2. Select the type of Runner from the Member Select panel in the Reuse Library. For this
component use Runner[4].

3. Select 6.5 from the D1 drop-down list and enter 92 and 50 in the L1 and L edit boxes in
the Details rollout of the dialog box. Select the Specify Point area in the Placement rollout
and position the runner, refer to Figure 15-130.

XC

Runner

Figure 15-130 The runner position and orientation in the model

4. After placing the runner, choose the OK button to close the dialog box.
Adding Cooling Channel

This tool helps you to add cooling channel. Cooling channel helps to solidify the material.
Effective cooling channel helps you to reduce cycle time.

1. Choose the Pattern Channel tool from the Cooling Tools gallery of the Mold Wizard “wﬁﬁ‘:’
tab, the Pattern Channel dialog box is displayed, refer to Figure 15-131.

2. Select the Sketch Section button in the Channel Path rollout, the Create Sketch dialog box
is displayed, refer to Figure 15-132.
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Figure 15-131 The Pattern Channel Figure 15-132 The Create Sketch
dialog box dialog box

3. Create sketch for cooling channel on a plane and choose the Finish button to exit the sketch
environment; the Pattern Channel dialog box is displayed. Specify the diameter of channel
in the Channel Diameter edit box of the Setting rollout. Choose the OK button to close the
dialog box. Refer to Figure 15-133 for cooling channel position and orientation.

Coaoling

Figure 15-133 The orientation and position of cooling channel

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. The tool is used to define the path of the mold project.

2. The tool is used to assign the core and cavity regions in the model.
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3. There are types of Configuration in the Initialize Project dialog box.
4. You can change the orientaion of the model by the tool.
5. The tool is used to apply the material on model.

6. Gate is a channel which connects sprue bush to the component. (T/F)
7. Runner is a channel which connects sprue bush to the gate. (T/F)
8. Shrinkage is used to apply scale factor to the component. (T/F)
9. The Patch Surface tool is used to create the sheet to close the openings in the model. (1/F)
10. The Design Fill tool is not used to create gate. (1/F)
Review Questions
Answer the following questions:

1. Which of the following dialog boxes is displayed when you choose the Patch Surface tool
from the Parting Tools gallery of the Mold Wizard tab>

(a) Patch Surface (b) Edge Patch
(c) Patch (d) None

2. Which of the following tools in NX Mold Wizard is used to create core and cavity regions?

(a) Check Regions (b) Define Regions
(c) Patch Surface (d) None

3. Which of the following dialog boxes is displayed when you choose the Set Cavity button
from the Easy Fill Advanced tab to specify the cavity of the component?

(a) Set Cavity (b) Select Cavity

(c) Cavity (d) Set
4. The tool is used to create parting surface of the model.
5. The tool is used to add cooling fitting components to cooling channels.
6. The tool is used to adjust the position of the cooling channel.

7. You can select the material from the Select Cavity dialog box. (T/F)

8. The Design Gate tool is used to create the runner. (T/F)
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9. The Assembly Drawing tool helps you to create the drawing of the mold assembly.

10. The Slider and Lifter Library tool helps you to create slider in mold design.

EXERCISE

To perform the exercise you need to download the zipped file named as ¢c15_NX_2019_input from
the Input Files section of the CADCIM website. The complete path for downloading the file is:

Textbooks > CAD/CAM > NX > Siemens NX 2019 for Designers > Input Files

After the file is downloaded, extract the folder to the location C:|NX 2019\ and rename it as cl5.

Exercise 1
Create the Mold Design of the model shown in Figure 15-134.

Figure 15-134 The Trimetric view of the Phone Case cover

Answers to Self-Evaluation Test
1. Initialize Project, 2. Check Regions, 3. three, 4. Mold CSYS, 5. Initialize Project, 6. F, 7. T,
8.T,9.T,10. F



